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21st November  New Products Mark Worrall

5th December  Internet Evening Dennis Linzmaier
19th December  Christmas Party Riverside Centre
2nd January Corel Draw & Corel Photopalint Ian Capon
16th January PDA’s (Personal Digital Asst.) Dennis Linzmaier

6th February  A.G.M. followed by Questions and Answers

20th February  Linux Update Bob Groom
6th March World Wide Disability E-mail Groups To be advised
20th March Building a Computer Dennis Parkes
3rd April Net Meetings & Instant Message Systems Dennis Linzmaier

17th April Spreadsheets David Broughton
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DP Computers IOW
Supporting IWPCUG and Computability

SPECIAL OFFER AT THE SHOW ONLY
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Mice and Trackballs Sound Cards

Speakers Complete PC’s

Plus many other items - enquire at the Stand in the Main Hall, Area 1
Tel. 616616

Or visit - http://www.dpcomputersiow.co.uk
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EDITORIAL

m elcome to the 12th IWPCUG’s Annual Computer Show.

This year brings together specialists in the field of IT and there are some new
exhibitors at the 2001 Show who will have many items of interest on show.

If you are at a loss on what to buy for Christmas presents, then this Computer
Show, once again should give you an opportunity to bless your family or friends
with the right gift. There will be something for everyone including computers,
printers, CD Rewriters, sound cards, modems, mice etc.

IWPCUG STAND
If you would like advice on which computer or software to buy or you have a
problem our staff at the stand will be pleased to assist you. If you would like to join
our Computer Club, we are offering a £2 discount on our membership fee of £12
per year, to people who join on their visit to the Show.

COMPUTABILITY
IWPCUG have a section that loans computers and gives training to people who are
physically disabled or have learning disabilities. This group will be represented at a
stand at the Show and will be offering advice on special computer aids and services
for the disabled. Come and have a chat to the staff on duty and encourage them in
their worthy work for the disabled.

THE INTERNET

An on-line Internet Stand will be available in Area 3 where you can discuss with
the staff on duty any questions that you might have. The Internet has become a vast
area in the computing world with many different service providers and the number
of websites on the Internet has expanded enormously, to incorporate thousands of
shopping sites plus many search engines, which can help you with advice on any
topic and sometimes be a great help when you are stumped. There are also umpteen
newsgroups to join if you would like to know more about a particular piece of
software or general questions on hardware.

We hope that you will enjoy the Show and find the exhibitors’ stands of interest
and value to you. Take the time to stop and chat to each exhibitor so that you can
perhaps find out something that you were not aware of before you visited the
Computer Show. As well as information, there are always bargains to be had, not
least, new friends to be made. So take the opportunity that you have of asking
questions and improve your knowledge of Information Technology. The computer
has become an important household tool but how many of us are using this
technology to the full?
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The club meets on the first and third Wednesdays of the month at
The Riverside Centre in Newport at 7.30 pm. All levels of experience and knowledge
are welcome, from novice to expert.

MEMBERSHIP APPLICATION FORM
Membership is £12 per year but if you join at the Show the subscription
is only £10.

You can still join by post for £12 using this form. Please send this completed form with your

cheque (made payable to "The Isle of Wight PC User Group") to:
The Membership Secretary, IWPCUG, 2 Westview, Hulverstone, Newport, L W. PO30 4EH

Title Initials Surname

Forename Date of birth / J

Address

Postcode Home Phone Work Phone

Job Employer

E-mail address

Special Interests/favourite software

Associates:
You may add here the name(s) of other person(s) as Associate Members who live at the same
address (Associate Members do not pay a subscription) or an organisation that you
will represent:

[ hereby apply to become a member of the IW PC User Group.
I agree to abide by the constitution.

DATA PROTECTION ACT, 1984. 1agree that any of the details given on this form may be held
on the Group's database and may be disclosed to any other member of the Group. I undertake
that such information concerning another member of the Group will not be disclosed to a non-
member except with the further permission of the member concerned.

Signature Date / /



SOME NOTES ON FILE TYPL.s
by David Broughton

There has been some confusion recently over
what is meant by plain text" files. An
example was the expression "send it as a
plain text HTML file" which seems at first
sight to be a contradiction of terms. How can
a file be both "plain text" and HTML?

The confusion over file types stems from the
fact that what one sees on the monitor screen
when a file is displayed depends very much
on the software that is displaying it. All files
require some kind of formatting and this must
be picked up either from the file itself or the
software must do its own formatting
according to context.

PLAIN TEXT

Plain text files are the simplest of files that
contain a minimum of format information.
Each character is stored in one byte as a 7-bit
code. These characters consist of the letters
of the alphabet, both upper and lower case,
plus numerals and punctuation signs. The
only formatting information is in the form of
control codes, the principle one being a
newline character.  Plain text files are
sometimes called ASCII (American Standard
Code for Information Interchange) files.

THE INTERNET
The Internet only handles plain text. Files

containing other format information and
codes other than plain text (i.e. characters

requiring 8 bits) must be coded into plain
text. Graphics files, for example, which use
all 8 bits of every byte, are coded using a
base 64 coding system. This converts every
three bytes of 8 bits into four bytes of 6 bits
that can then be represented by the letters of
the alphabet and numerals plus two
punctuation signs. The coding

looks something like this:

59CjS590vbr169iza90vbv37+BPgIYT368Q
IfcQfPXNJIB+BVY 34H28dcegwitx SB7AOrI
UYoNcRgfgiTWqKKAGuJ4odsgwgjhhwHK «

The pound sign used in most Windows
software is an 8-bit character (the value is
163). Whilst many people are able to
transmit the pound sign successfully in e-
mails, there is no guarantee that it will work.
My suggestion is to use UKP after the
numeral; for example "3.99 UKP". Most
people will have seen money quantities, in e-
mails, without the pound sign in front and
may wonder why it is missing. Basically, the
reason is that the pound sign is not part of
plain text.

ATTACHMENTS

When an e-mail contains an attachment that
is base-64 encoded, obviously, the recipient
does not want to see the coding. The e-mail
software takes care of the conversion
automatically in the background when the
attachment is opened. But you can see the
coding if you wish by viewing the e-mail
with an editor like Notepad. (More about this
below.)

THE META-LANGUAGE HTML

An HTML (Hyper Text Markup Language)
file is a plain text file with formatting using
the meta language HTML. A meta-language
is a set of rules using the main language that
implies a special use when interpreted by the
particular software it is designed for.




A very simple case would be to display a
particular piece of text in a bold font. Since
there is no plain text version of a bold font
one could use the symbols <B> to denote
where the bold font is to start and </B> to
mark the end. The < and > symbols are meta-
language symbols because they use the main
language (plain text) in a special way.
Viewed as plain text (in, say, Notepad) you
will see <B> and </B> but if presented to
some software that understands the meaning
of these symbols (such as a web browser) it
will show the text between them in a bold
font.

Note that this implies that the symbol <
cannot be used in its conventional sense,
meaning "less than". So the meta-language
has to have some means of representing the
less than sign when needed for its original
purpose.
sign, incidentally, is coded as "&pound;" in
HTML or alternatively "&#163;" which
shows how extra symbols can be
incorporated into a restricted alphabet. Here,
the ampersand symbol (&) is being used in a
special way.

HTML is the language used by Web
Browsers, providing a sophisticated set of
formatting options (such as lists and tables)
that are not easy to provide with plain text
alone. It also has provision for a variety of
fonts, sizes and colours of text. But the
HTML file is plain text and can be
transmitted over the internet as it is (i.e. not
coded into base 64 or any other coding
scheme).

This is no problem. The pound.

WHAT YOU SEE DEPENDS ON THE
SOFTWARE

To emphasise the point, how a file appears on
the computer monitor depends on the
software that is used to display it. Thus, an
HTML file displayed with a web browser
will display the file formatted according to
the meta-language HTML. If the same file is
viewed in, say, Notepad, it will be displayed
as plain text and so will include all the meta-
language tags and other language constructs
that only an HTML person would be able to
understand. Generally, it would be difficult to
read.

If you viewed a graphics file (say, a GIF file)
in Notepad, you would see gobbledygook
because Notepad has no knowledge of the
format used for graphics files. Let a web
browser or graphics program open it,
however, and you will see the image because
it understands the coding.

Now send the GIF file as an attachment in an
e-mail over the Internet and it will be coded
in base 64 with the file type GIF. This will be
mentioned in the header information of the
attachment coding. When the e-mail is
received, the software will show, for
example, a paper clip symbol to denote the
attachment. Clicking on this symbol starts a
chain of events as follows: first, the base 64
coding is decoded to produce a binary GIF
file. This is placed in a temporary location
on the hard disk. The name and place of the
file is passed to the operating system which
uses the file type information (GIF) to choose
an appropriate piece of software to open the
file. The software chosen is determined by
the file associations table (more about that
below). The graphics program opens the file
to display the image.

You don't need to send a file as an
attachment if it is already a plain text file
(though you can). The file could simply be
inserted as part of the e-mail's plain text.

Continued on page 10
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An HTML file, being a plain text file, can be
inserted into an e-mail in this way. This will
display at the other end as plain text by the e-
mail software. This might not be very
interesting to the general user. But to a web
page author it could be something that is
wanted for cutting and pasting into a web

page.

Insert an HTML file as an attachment,
however, and when the recipient clicks on the
paper clip symbol, a web browser will start
up to display it formatted.

Neither of these types of e-mail should be
confused with "HTML e-mails”". What is
usually meant by HTML e-mails is e-mails
composed with software that has the
capability to encode the composed text, with
its formatting, into HTML, possibly also
containing images, making a multi-part
email. Multi-part e-mails are divided into
their various parts and which part is
displayed when received depends on the
received software's capability and the user's
options. If there is an HTML part, it is
usually decoded and displayed as the default.
But there is always a plain text part that you
can get at if you know how (depends on the
software).

But HTML used by e-mail software is limited
in its capability. It is frowned upon by many
because it: 1. Increases the size of e-mails by
a large factor, from three to ten times. 2.
Forces the recipient to view the text as the

composer composed it. 1f this was in a tiny

or unusual font the reader may have difficulty
reading it. The usual font size options are
disabled on some e-mail packages when
HTML is the source. It has the advantage
that images can be sent, embedded with the
e-mail text, but this tends to make the e-mails
even larger. The images are coded into base
64 as separate parts of the e-mail. 3. Some
viruses transmitted by e-mail are coded in a
form of HTML. This is a serious matter
because some e-mail software, like Outlook
Express, has as default a preview pane set on.
This displays the e-mail in a separate pane as
soon as the e-mail is selected from the main
list. 1If such an e-mail contained a virus it
would have been automatically activated and
you are in trouble. To switch off the preview
pane in Qutlook Express, on the View menu,
click Layout. Then make sure the box
labelled "Show preview pane" is not ticked.
This will prevent you from accidentally
activating a virus. If you suspect a virus in
an e-mail you can view it using Notepad or
other plain text editor that will not be able to

interpret the special formatting tags.
Although the HTML text will be difficult to
read, there will always be a plain text version
as well that is easily read. The Notepad
view, by the way, will show all the header
information which you have to skip over first.

To view an e-mail with Notepad, highlight it
and use "Save as" from the File menu and
save it in a temporary folder somewhere. I
use the Windows desktop. I then switch to
the desktop and drag the file's icon over the
Notepad icon. You can also set up an "Open
with" option with Notepad as one of the
options. More about this below.

An alternative way is to start up Notepad and
open the .eml file. Clicking on an .eml file
will not work because .eml files are
associated with the e-mail software. So
another way is to rename the file to a .TXT
file type and double click that after the
renaming. Files type TXT are associated
with Notepad usually.



FILE ASSOCIATIONS

I have spoken a lot about file associations so
perhaps more explanation is required. The
fact is, one of the ways a computer can be
more easily operated is to use a file
associations table and this is what Windows
and most other user-friendly operating
systems use. It consists of a table of file types
and software applications so that most file
types used in the computer can be associated
with the software that is appropriate. Take the
word processing program Word, for example.
The file type for letters and documents
produced by Word is .DOC so that if you
double click on a file of this type, the
operating system looks up its table of file
associations and starts up Word, feeding the
file name to it as a parameter as if you had
started up Word without a file, clicked on
Open in the File menu and navigated to that
file.

More than one file type can be associated with
the same application software, but only one
application software can be associated with
the same file type. However, sometimes you
may want to use a different piece of software
to open a file. Although you can do this in the
old fashioned way (start the application
software first and read in the file with
"Open"), the software can be placed in the file
associations table but not as the default. To
use alternative software for any file type, you
must first set up the name of the software in
the file associations table for that file type and
include it under the action "Open with". Then
when you right click the file you will get a
selection of applications for opening the file
which will include those you added. The file
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associations table can be seen by clicking
on My Computer and then View and
selecting Folder Options... Then select the
File Type tag. In Windows 95 and 98 the
Application software is in alphabetical order
rather then the file types, which is awkward so
that you have to scan down to find the one
you want. This was corrected in Windows
ME where the file types are in alphabetical
order. The Windows help screens will guide
you through any changes you want to make to
this table.

FILE TYPES

I have spoken a lot about file types but not
fully defined them. Originally, in the days of
DOS, file types were up to three characters
after the dot of the file name and called the
file name extension. Windows 95 and later
versions allowed long file names that could
contain dots -- dots within the file name part.
This can be confusing because the file type is
the last set of characters that follow the last
dot. So if there is more than one dot you
could be fooled into thinking that the file type
is different from what it is, especially as, by
default, Windows does not show the file type
in file listings. The advantage of this to a
virus writer can be imagined. I nice little
EXE file (executable) can be named "My
picture.jpg.exe" containing a virus. The user
sees this as "My picture.jpg" and expects to
see the picture when it is double clicked. But
in fact it is not a jpg file but an exe file and
you get infected with the demonic doings of
the virus writer.

To make sure you see all file types, go to
Folder Options from My Computer/View
(also available from the Settings menu that
comes up from Start) and select the View tag.
Scroll to the message "Hide file extensions for
known file types" and make sure the box next
to this message is not ticked. Then remember
an important rule: Never double click an
attachment that is an EXE file unless you
know for sure who the sender is and that the
attachment was intended (because sometimes,
even if you know the sender, the sender may
not realise that an attachment has been sent).
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About
The Isle of Wight
PC User Group

The Isle of Wight PC User Group exists
to help Island residents in the use of
computers in their everyday lives and as
a hobby. The disabled are particularly
encouraged to explore the facilities that
computers can provide to enhance their
lifestyle.

The club meets twice monthly at The
Riverside Centre, Newport, on the first
and third Wednesdays of each month at
7.30 pm. Visitors are welcome.

The club is open to all who are
interested. The talks range from Do-It-
Yourself hardware changes to how to
operate popular items of software and
use the Internet.

The subscription is £12 per year but as a
special concession for visitors to the
Annual Show, you can join today (18
Nov. only) for just £10 (for the
remainder of the year 2001 and all of
2002). The club's stand is in Area 3

which is known variously as the
"Workshop" and the "Phase 3 Lounge".
It is the room at the bottom of the main
corridor. If you would prefer to make
your mind up later, please come along to
one of our meetings as a visitor.

+ The club has a website at:-
http://www.ddina.demon.co.uk/iwpcug/

where you will find a list of future
meetings, the Constitution, a list of
Committee Members, an application
form to join and much, much more. In
particular there is a section devoted to
what we call "Computability". The web
site gives details of computing aids that
can be obtained for the disabled. In
practical terms, the club's Computability
activities provide help to Island residents
(not just its own members) to get the best
they can from owning a computer.
Many of these residents are loaned
computers on a trail basis with one-to-
one instruction from our volunteers.
Helping such people is not only a useful
contribution to society but is also a
rewarding activity for the volunteers.

The club's magazine, Hot Key, is issued
monthly. (The edition you are reading is
a special version produced as a guide for
the Annual Show.) Hot Key contains
articles on software and hardware with
advice for those new to computing; in
fact, it tries to reflect the talks given to
members at the meetings.

More information about Hot Key and the
club is on the web site.

Compiled by David Broughton
Show Organiser
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Microsoft Windows XP offers you many new features and its excellent overall performance,
which includes dramatically faster boot and resume times, along with highly responsive
applications

Windows XP is the best-performing Windows operating system ever created.
Microsoft recommends that computers running Windows XP have at least 128 megabytes
(MB) of random access memory (RAM) installed.

While Windows XP does not require a state-of-the-art processor for a good user experience,
the minimum is a 300-megahertz (MHz) Pentium Il-class processor; the system can benefit
from faster hardware. The operating system, particularly the Windows XP user interface
(UD), is sensitive to the quality of the video subsystem and video drivers. On-board video
memory will ease the processing burden on the general purpose RAM used by the operating
system and applications. And because individual drivers can cause problems for system
performance, Microsoft is working with the industry to ensure that high-quality drivers are
available for the broadest cross section of devices possible.

Features
e New look - The user interface has been completely L o Decments _
redesigned to make things simpler. However if you prefer od Mot ot |
the look and feel of the traditional Windows interface, 2 e e
you can revert to the normal look and feel of Windows. ' g
I {7 [ g oy Conmgutn
o Stability - The new Windows engine based on the | @ e g
Windows 2000 platform is the most dependable system to | %% . i
date. It also has improved hardware support and enhanced | (g...... . a i “'
Internet security in the form of the built in Internet P e g
Connection Firewall, . ! W
’JM
80 Prig s b T b,

» Easy to operate - Apart from the new Welcome Screen,
Windows XP offers multi-user support so that more than
one person can easily use the same PC and presents
different personalised log-on icons on the Welcome Screen for the various users.

¢ Entertainment - New features have been added to Windows XP, which offers support
for multiple devices, such as digital cameras, video, music players, PDAs and scanners,
plus you can store and edit pictures, movies and music to a better degree.

+ One Step CD Burning - Put a blank CD into your CD-RW drive and drag your files
into the appropriate folder. Start burning and that’s it. Easy to use and quick.

*  Driver Rollback - If you install the wrong driver, which may cause problems, simply
right click on the hardware in device manager, click on properties and select the driver
tab and rollback to a previous driver installation.
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RAFFLE

The top prize in the raffle is a multi-media computer
with colour Deskjet printer.

Tickets are £1 for a strip of five tickets.
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The raffle will be drawn at 3.30 pm. Proceeds from the raffle will go to help
disabled people in the use of computers to enhance their lifestyle -- part of the
® activities of the Isle of Wight PC User Group.

TECHNICAL DETAILS of the first prize:

Processor: Celeron 800 MHz
Power Supply: ATX 300 Watts
Coloured Midi Tower Case

4 AGP Slot
L 4 56.6 V90 AMR Modem
2 5 PCI Slots
128 Megabytes of RAM
& PCI133 Dimm
& 8x4x32 CD-Read-Write
@ 8x DVD (CD Compatible)
& 17" AOC Colour Monitor
& Windows 98 SE Operating System
'Y 160 W Stereo Speakers
¢
2
&
¢
L 2
¢
24
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Multi Function 4D Trackball mouse
Windows 98 Keyboard.
HP DesklJet 640 Colour Printer
.. plus the DVD now showing!

Supplied by D.P. Computers IOW with one year warranty.
Worth £800 retail.
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MEMBERSHIP SUBSCRIPTIONS

If you sign up at the IWPCUG stand in the “Workshop” (Area 3) you will be entitled to a
£2 discount on the yearly subscription to the Computer Club. This also applies to current
members who wish to renew their membership for 2002.

The fee will be £10 instead of the usual £12 per year




“When your computer needs attention you want to phone for help in your
own premises, at a time convenient to you. Not disconnect it, take it to the
nearest shop and wait for it to be repaired, then transport it back and hope
all iswell.”

Call Steve France for:-
eRepairs & Problems
eUpgrades

eSmall Business Services
o\\eb Design & Publishing
oConsultancy & Training

Exhibition Special Offers
Full Multimedia PC-1.1Ghz AMD Processor, Delivered & Installed £699

128Mb PC133 Memory - Supply £15, Supply & Fit £25
20Gb Hard Disk - Supply £75, Supply & Fit £99

17" Monitor - Supply £139, Supply & Fit £149

16X DVD - Supply £69, Supply & Fit £85

Phone: 280529
Mobile: 07780 672228
Email: sales@compuwight.co.uk
Web: www.compuwight.co.uk




COMPUTER R3]
TRAINING ECET

You must book your training = hc‘ '
before December 7th to get up -‘onh‘
to 80% of all your training costs!

Train for as little as £35

If you already have an ILA card
then why not book with the BEST!
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